BD CellQuest Pro™ Acquisition Tutorial

Introduction

This tutorial guides you through a CellQuest Pro Acquisition run like the one
demonstrated in the CellQuest Pro Acquisition Movie on the BD FACStation™
Software CD-ROM.

This tutorial covers:

Setting up an acquisition Experiment document

Optimizing samples using CellQuest Pro acquisition features
Setting up for sample acquisition

Acquiring data

Before starting this tutorial you will need:

1.

2.

CellQuest Pro Version 4.0 or greater, BD Inits 3.4, and QuickTime

version 4.0

To view the CellQuest Pro Analysis Movie and complete the CellQuest Pro
Analysis tutorial

A BD FACScan™, BD FACSort™, BD FACSCalibur™, BD LSR, or BD FACS
Vantage™ flow cytometer

A panel of lysed whole blood tubes stained with the following

BD SIimulTEST™ reagents: LeucoGATE™, 1gG,/1gG, isotype control,
CD3/CD19, CD3/CD4, CD3/CD8, CD3/CD16+CD56

Alternatively, if you do not want to use SimulTEST reagents, you can use
BD CaliBRITE™ beads. You will need two tubes, one with unlabeled beads
in 1 mL of sheath fluid and the other with FITC-, PE-, and unlabeled beads
in 3 mL of sheath fluid. Although CaliBRITE beads were not used in the
overview demonstration, the steps required to optimize and acquire beads
are similar to the ones shown for the optimization and acquisition of lysed
whole blood samples.

A two-color panel was chosen for this acquisition tutorial to allow you to
focus on the CellQuest Pro features. Once you are more familiar with
CellQuest Pro’s features, you can apply what you have learned from the
tutorial to experiments with three or more colors.

NOTE: Steps appearing in boldface are key instructions. Additional information
is provided in plain text.

Before you begin, follow the instrument start up procedure in the CellQuest Pro
Software User’s Guide.
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A. Launching CellQuest Pro

Launch CellQuest Pro by double-clicking the Standard Acquisition
Experiment document in the Sample Files folder.

The Samples Files folder is in the CellQuest Pro Folder. When CellQuest Pro
is launched, the Experiment document appears with the plots and statistic
views that were last saved. The document is a template containing four
acquisition plots, quadrant markers, and quadrant statistics boxes that have
been edited to display % Gated statistics.

B. Optimizing Samples Using CellQuest Pro Acquisition Features

Before data is collected, you need to optimize the electronics for your
samples. The settings can be optimized with cytometer controls accessed
from CellQuest Pro software. The optimization sequence is as follows:

* Adjust FSC and SSC detectors and FSC threshold

» Gate on the population of interest (lymphocytes or beads)

* Adjust FL1 and FL2 detectors

* Adjust fluorescence compensation.

1. Choose Connect to Cytometer from the Acquire menu.
The Acquisition view of the Browser appears. Click and drag the
Browser window to a clear area of the screen. If necessary, resize the

window.
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2.  Choose Detectors/Amps from the Cytometer menu.

The Detectors/Amps window appears. Click and drag the window to
a clear area of the screen.
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Choose Threshold from the Cytometer menu.
The Threshold window appears. Click and drag the window to a clear
area of the screen.

NOTE: When you save your CellQuest Pro Experiment document, the
location of the instrument settings windows (Detectors/Amps,
Threshold, and Compensation) will also be saved. The next time you
open the windows, they will appear in the last location you placed
them.

C. Adjusting the FSC and SSC Detectors and FSC Threshold Setting

You need to adjust the FSC Amp Gain, SSC Voltage, and FSC Threshold to
appropriately display the scatter properties of the lysed whole blood
sample or the beads. Use the FSC Amp Gain and SSC Voltage to place the
population of interest on scale. Use the FSC Threshold to exclude any
unwanted debris and noise.

NOTE: Click the Pause and Restart acquisition controls periodically during
the optimization process to quickly update the events displayed in the plots.

1.

2.
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Place the flow cytometer in RUN mode.

Place the isotype control tube or the unlabeled CaliBRITE beads
tube on the sample injection port (SIP).

Click Acquire in the upper pane of the Browser.

Note that the Setup check box in the Acquisition view of the Browser is
checked. This allows you to click Acquire and view real-time
acquisition display without saving a data file.

Verify the FSC Amp Gain Mode is Lin and FSC Voltage is EO0 in the
Detectors/Amps window.

Adjust the FSC Amp Gain.

Click the up or down arrow of the FSC Amp Gain to place the
lymphocytes or the unlabeled beads in the desired location in the FSC
vs SSC plot. See Figure 1.

NOTE: There are several ways to adjust instrument settings:

* Click the up or down arrow to increment or decrement the value
by 1.

* Hold down the Option key, and click the up or down arrow to
increment or decrement the value by 10.
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* Click and hold between the two arrows to get a slider bar and drag
the slider.

P1 FsC Lin |z
P2 ssC Lin ¢
P3  FLI Log |
P4 FL2 [Log %]
P5  FL3 Log |
P6  FL2-4 1.00 Lin
P7  FLZ-W I.Dl] Lin
#7 fi4 100 j Log

DDM Param:
Detector/ Amps window (FACSCalibur Instrument)

Verify that the Mode for SSC is Lin.

Adjust the SSC Voltage.
Place the lymphocytes or unlabeled beads in the desired location in the

FSC vs SSC plot. See Figure 1.
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Figure 1

Adjust the FSC threshold in the Threshold window.

Set the threshold to remove most of the debris without cutting off the
population of interest. It might not be necessary to adjust threshold if
you are running beads because there is very little debris. See Figure 2.
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D. Gating on the Population of Interest

To ensure that fluorescence instrument settings are optimized for only the
population of interest, draw a region around the lymphocyte or bead population.

1. Click the Polygon-Region tool in the tool palette to select it.

FINENEE
F
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2. Click on the FSC vs SSC plot to place the first vertex of the polygon
region.

3.  Drag the cursor to the next location and click again to place the next
vertex.

4.  Continue the process until the lymphocyte population is surrounded and
the first vertex is reached again.
Once the first and the last vertex meet, the region is complete. Alternatively,
once you are near the first vertex, double-click the mouse to close the region
automatically.
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You can modify a polygon by clicking on the region outline once to select it.
Once the square handles appear, click and drag on a handle to resize the
region. To move an individual vertex, double-click on the region outline.
Click on one of the square handles that appear and drag to the desired
location.
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Figure 3

E. Adjusting the FL1 and FL2 Detectors

The FL1 and FL2 Detectors might need adjustment. To do so, place the
isotype control of the lysed-whole blood sample or the unlabeled beads in
the lower left-hand corner of the FL1 vs FL2 plot. Format the FL1 vs FL2 dot
plot to display only events from region R1, the population of interest.

1. Select the FL1 vs FL2 dot plot.
To select a plot, click on the border of the plot. Square handles appear.

2.  Choose Show Inspector from the Windows menu.
The Inspector window appears. The Inspector window allows you to
view and modify the attributes of nearly any item in CellQuest Pro.
For example, you can use the Inspector to quickly change parameters
and color events and choose font types for plots.

Items in the Inspector can change, depending on the object or group of
objects selected. When an object is active or deselected, the Inspector is
empty.

3.  Choose Gate G1=R1 from the gate pop-up menu in the Inspector
(Figure 4).
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Figure 4

Click the quadrant marker intersection in the FL1 vs FL2 plot to
select it.
These markers will designate areas of negativity and positivity.

Drag the handle of the markers so the cross-hairs are at 10' and 10*
on the X and Y axes, respectively.

If necessary, adjust the FL1 and FL2 voltages in the Detector Amps
window to place the negative population in the lower-left quadrant.
(Figure 5).

Verify that the FL1 and FL2 Modes are set to LOG. To increment or
decrement the voltage by 10, click the up or down arrow of the FL1 or
FL2 voltage while pressing the Option key.

zition Dot Plok

Figure 5

Click Pause in the Acquisition Browser.

Remove the isotype control tube or the unlabeled bead tube from the
SIP.



9.

Click the close boxes of the Detectors/Amps and Threshold windows
to remove the windows from the screen.

F.  Adjusting Fluorescence Compensation

The last step in the optimization process is adjusting for spectral overlap.
You will adjust the FL1-%FL2 and FL2-%FL1 compensation networks using
the CD3 FITC/CD19 PE tube or the tube containing FITC, PE, and
unlabeled CaliBRITE beads (mixed bead tube).

1.
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Choose Compensation from the Cytometer menu.
The Compensation window appears.

Click and drag the window to a clear area of the screen.

Place the CD3 FITC/CD19 PE or the CaliBRITE mixed bead tube on
the SIP.

Click Restart in the Acquisition Browser.

If necessary, adjust FL1-%FL2.

Click the up or down arrows to place the PE population in the upper-
left quadrant. Align the FL2 positive population with the negative
population. See Figure 5.

If necessary, adjust FL2-%FL1 to place the FITC population in the
lower-right quadrant.
See Figure 6.

Acquisition Dat Plot Acquisition Dat Plot

Cells with compensation optimized Beads with compensation optimized

Figure 6

Click the close box of the Compensation window to remove the
window from the screen.



8. Click Pause, then Abort in the Acquisition Browser.

9. Remove the tube from the SIP.

10.

11.

Place a tube of DI water on the SIP.

Setting Up the Experiment Document

Place the cytometer in STANDBY mode.

For this acquisition example, you will create tube-specific plots and choose
a panel. The tube-specific plots feature allows the data from tubes already
acquired to remain in the plots so you can view them as you continue

acquiring.

If you are acquiring cells, continue with the steps in this section for cells.
If you are acquiring beads, proceed to page 13.

Acquiring Cells

1. Choose Show Browser from the Windows menu if the Browser is not

already opened.

The browser appears.

2.  Click the pop-up control and choose Load Tubes from Panel; select
the IMK Lymph panel.
Note that your browser might appear different from the one shown,
depending on whether or not the disclosure triangle is open or closed.
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3.  Click the disclosure triangle for the IMK Lymph folder so that it
points down.
A list of six tubes appears. A pointer points to the first tube in the

panel.
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4.  Select all the plot in the Experiment document.
To select the plots, press and hold the Shift key and click on the border
of each plot. Square handles appear on the corners of the plots when
they are selected.

NOTE: Do not select the statistics views.

Figure 7

5.  Select Acqg -> Analysis from the Plot Type pop-up menu (Figure 8).
All selected plots become Acq -> Analysis plots.

11-11047-00 10



T Tepeoter DolPREL T
= Basic Plot
Plot Type  hoq->Analysis
File Mo File

Tube  Leucogate
WParameter FSC 1024 FSC-H
¥ Parameter SSC 1024 SSC-H

=
=
=
=
=

Gate Mo Gate
Plot Title  Acquisition Dot Plot
Show Title [
~ Dot Plot
Show Dots 1000 =
Identify Event ]
ewent Color ] [ MuttiCaler Gating
= Geometry

Location (inches) Tup L?H
Size (inches) W\d(h ngm

= Text Style
Font  Helvetics =
Size

E_1 =
syl [B]Z]u]E[e]c]E|
Justification

Text Color [

Background _ Unsupported =

[T

Figure 8

6. Change the two plots not displaying FL1 vs FL2 in the Experiment
document to FL1 vs FL2 plots.
Make sure only the two plots are selected. In the Inspector, choose FL1
for the X Parameter and FL2 for the Y Parameter.

7. Use the Duplicate feature to create three more FL1 vs FL2 plots.
To duplicate a plot, make sure the plot you want to duplicate is
selected (square handles appear at the corners of the plot) and choose
Duplicate from the Edit menu. A duplicate of the selected plot appears.
Repeat the process until all the plots are created.

At this point, you should have a total of seven dot plots, one FSC vs SSC
plot and six FL1 vs FL2 plots. Next, you will make these plots tube-specific
plots.

1. Select the FSC vs SSC and the FL1 vs FL2 plot next to it.

2.  Click the Tube pop-up menu in the Inspector and choose
LeucoGATE (Figure 9).
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The LeucoGATE tube is the first tube in the panel. The two plots are
now associated with the LeucoGATE tube. When this tube is installed
on the cytometer and the Acquire button is clicked, live data will
appear in the plots. Immediately following the completion of
acquisition, the plots will display data from the LeucoGATE tube’s
data file.

Select an FL1 vs. FL2 plot not yet assigned to a specific tube.

Choose Mouse 1gG,/Mouse 1gG,, as the tube from the Tube pop-up
list in the Inspector.
This plot is now associated with the second tube in the panel.

Repeat steps 3 and 4 to create a tube-specific plot for the rest of the
tubes in the panel.

Choose Save As from the File menu.
The Save As dialog box appears.

Name your document Acquisition 1 and navigate to your folder on
the desktop; then click Save.

Your acquisition document is saved in the same folder as your
Analysis document.

The FSC vs SSC and one of the FL1 vs FL2 plots are specific for the
LeucoGATE tube. The other five FL1 vs FL2 plots are specific for the other
five tubes in the panel.

8.
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Proceed to Section I.
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Acquiring Beads

You will create a panel and choose the panel in the Experiment browser.
You will also create tube- specific plots.

Creating a Panel

1. Choose Edit Panels from the Acquire menu.
The Edit Panels dialog box appears. See Figure 10.
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Figure 10

2. Click Add above the Panels column.
A new panel appears under the existing panel.

3. Enter Beads Panel as the panel name.

4.  Click the selection icon to the left of Beads Panel to select the panel
and click Add above the Tubes column.
Tube #1 appears in the Tubes column.

5. Click the selection icon to the left of tube #1 to select the tube.

6. Choose Forward Scatter as the label for the P1 parameter from the P1
pop-up menu under the Labels column.

Edit Panels...
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10.

11.

Choose Side Scatter as the label for the P2 parameter.

Click Add above the Tubes column.
Tube #2 appears in the Tubes column.

Choose the P1 and P2 parameter labels for tube #2.

Enter FITC in the P3 field and PE in the P4 field. Press Tab.
Pressing Tab accepts the typed in entries.

Click OK.

Choosing a Panel and Creating Tube-Specific Plots

1.
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Choose Show Browser from the Windows menu.

The Browser appears.

Click the pop-up control and choose Load Tubes from Panel; select

the Beads Panel (Figure 11).
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Click the disclosure triangle for the Beads Panel folder so that it

points down.

A list of two tubes appears. A pointer points to the first tube in the
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10.

11.

Move the Browser to a clear area of the screen.

Select all the plot in the Experiment document.
NOTE: Do not select the statistics views.

To select the plots, press and hold the Shift key and click on the border
of each plot. Square handles appear on the corners of the plots when
they are selected. See Figure 7.

Select Acq -> Analysis from the Plot Type pop-up menu (Figure 8).
All selected plots become Acq -> Analysis plots.

Select the FSC vs SSC and the FL1 vs FL2 plots in the Experiment
document.

To select both plots, press the Shift key and click on the border of each
plot. Square handles appear on the corners of the plots when they are
selected.

Click the Tube pop-up menu in the Inspector and choose tube #1.
The two plots are now specific for the first tube. When this tube is
installed on the cytometer and the Acquire button is clicked, live data
will appear in the plots. Immediately following the completion of
acquisition, the plots will display data from the tube’s data file.

Change one of the plots not yet assigned to a specific tube to an

FL1 vs FL2 plot; choose tube #2 as the tube from the Tube pop-up list
in the Inspector.

This plot is now specific for the second tube in the panel.

Choose Save As from the File menu.
The Save As dialog box appears.

Name your document Acquisition 1 and navigate to your folder on
the desktop, then click Save.

Your acquisition document is saved in the same folder as your
Analysis document.

The FSC vs SSC and one of the FL1 vs FL2 plots are tube-specific for
tube #1. The other FL1 vs FL2 plot is tube specific for tube #2.
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I.  Selecting Acquisition and Storage Settings

Acquisition and Storage settings include the number of events to acquire
and the number of parameters to save.

1. Click on the disclosure triangle for Global Settings in the Browser
window.
The icon for Global Acquisition & Storage Settings is displayed.

2.  Make sure the Inspector window is open; then click on the Global
Acquisition & Storage Settings icon in the Browser window.
Acquisition and storage settings are displayed in the Inspector
window.

3. Verify that the event count is 10,000.
This is the number of events that will be saved in your data file.

OPTIONAL
To practice using the new feature of tube-specific settings, follow these
steps.

1.  Click on the pop-up menu to the right of the first tube in the panel
in the Browser and select Add Acquisition & Storage Settings.
An icon for Acquisition & Storage Settings appears indented, beneath

the tube. Note that the icon is the same as the one listed beneath Global
Settings; however the name next to the icon is different. These settings

are now specific only to the first tube.

2.  Click on the Acquisition & Storage Settings icon beneath the first
tube in the panel.
You can view the tube-specific settings in the Inspector window.

3. Change the event count to 2500.

4. Choose G1=R1 from the Collection Criteria pop-up menu (Figure 12).

Data acquisition for the first tube will stop when 2500 events are
counted in the G1 gate.
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You have just associated acquisition and storage settings with a specific tube in
the panel. You can also associate specific instrument settings with individual
tubes, if you want. For more information about tube specific instrument settings,
consult your CellQuest Pro Software User’s Guide.

J.  Setting Up the Acquisition View of the Browser

File Storage and parameter labels are defined in the Acquisition view of the
Experiment browser.

1. Choose Browser:Acquisition 1 from the Windows menu.

2. Click the disclosure triangle next to Acquisition Controls in the
Browser window to view the Acquisition Controls.

0O =————————Browser:untitled="——
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Directory: Hard Disk Celluest Folder - DireCtory Change bUtton
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Sample ID: | |
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Comments : | }:l

3. Click the Directory Change button.
The Destination Folder dialog box appears (Figure 13).
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Figure 13

4.  Click the destination folder pop-up menu.

5.  Choose Desktop.

6. Click the same folder that contains the Acquisition 1 Experiment
document; then click the Select button at the bottom of the dialog
‘tl)'ﬁ)é.dialog box closes automatically.

7.  Click the File Change button.
The File Name Editor window appears.

8. Type afile name in the highlighted Custom Prefix field.
9. Choose File Count from the File Name Suffix pop-up menu.
10. Click OK.
11. Enter Donor 1 in the Sample ID field.
12. Choose Save from the File menu.
The Acquisition Document is saved.
K. Acquisition of Two-Color Data

At this point, the electronics have been optimized for your sample and file
storage has been defined. The samples can now be acquired.

1. Deselect the Setup check box in the Experiment Browser.

2. Choose Counters from the Acquire menu.
The Counters window appears. For a full description of the window,
refer to the CellQuest Pro Software User’s Guide.

3.  Place the flow cytometer in Run mode.
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4. Install the LeucoGATE or unlabeled bead tube on the SIP;
immediately place the support arm under the sample tube.
Notice the parameter labels in the Acquisition Browser. If you are
using the IMK Lymph panel, the FL1 label is CD45 FITC and the FL2
label is
CD14 PE. If you are using the Beads Panel, the FL1 and FL2 labels are
the default labels because they were not defined when the panel was
created.

5.  Wait approximately 5 seconds; then click Acquire.
During this brief period, the sample tube is being pressurized.

Live quadrant statistics will be displayed as the data is acquired. The
system alert sounds at the completion of acquisition.

6. Remove the tube after the beep.

7. Place the next tube on the SIP.
Tube #2 is the isotype control tube in your reagent panel or it is the
mixed bead tube if you are acquiring CaliBRITE beads.

8.  Wait approximately 5 seconds, and click Acquire; then remove the
tube after the beep.

9. Repeat steps 6 and 7 for the remaining tubes, or if you are acquiring
CaliBRITE beads, skip to step 10.
Tube #3 = CD3 FITC/CD19 PE
Tube #4 = CD3 FITC/CD4 PE
Tube #5 = CD3 FITC/CD8 PE
Tube #6 = CD3 FITC/CD 16+CD56 PE
10. Place a tube of DI water on the SIP.

11. Place the flow cytometer in STANDBY mode.

You have successfully acquired your samples.
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